
Введение в Verilog  



Стандартные этапы проектирования устройства на FPGA  

Ввод описания проекта 

Моделирование, преобразование пользовательского описания в 
компоненты и примитивы, входящие в состав библиотеки FPGA.
RTL – Registr Transport Level (Уровень регистровых пересылок)   

Размещение полученных вентилей в ячейки
Временной анализ
Непосредственное размещение на микросхему и 
разводка связей    

Временной анализ с учетом параметров микросхемы 
и пользовательских ограничений

Конец разработки
Создание файла с конфигурацией устройства
Программирование микросхемы

Пользовательские
 ограничения

Логический синтез, преобразование файлов в схему соединений

Моделирование на логическом уровне

САПР
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Contents
• Етапы проектирования
• Модули

• Объявление
• Создание экземпляров
• Подключение портов
• Test-bench файлы 

• Adder (разработка сумматора)
• Проектирование
• RTL -моделирование
• Синтез
• Gate-level моделирование

• Приложение: создание проекта ‘adder’ 
в GUI (ModelSim)
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Объявление модуля
• Модуль – базовая единица проекта.
• Модуль должен быть задекларирован 

(объявлен). 🡪 подготовка
• Mодуль может быть конкретизирован 

(создан экземпляр) 🡪 использование
• Определение модуля должно вкладывается 

между ключевыми словами ‘module’ и 
‘endmodule’.

module module_name (список портов);
    // in, out, inout объявление портов 
    // signal/wire/reg объявление сигналов 
    // data variable объявление переменных 
    // sub-module создание экземпляров и                      
                           // подключение 
    // initial, always, function, task функциональные блоки, 
                      // описывающие логику работы компонента 
endmodule

module ModF (A, B, C);
    input           A;
    inout   [7:0] B;
    output [7:0] C;
    // описания 
    // описания ‘f’
endmodule

ModF

f
A

B
C
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Создание экземпляра модуля
module ModG (AA, BB, CC);
    input           AA;
    inout   [7:0] BB;
    output [7:0] CC;
    wire         a;
    wire [7:0] b; 
    // описание  ‘g’ 
    //   создание екземпляра ‘f’
    ModF Umodf (.A(a), .B(b), .C(CC)); 
endmodule

ModG

g
AA

BB
CC

f

a

b

ModF

f
A

B
C

создание экземпляра 

Соединение 
портов 

Имя экземпляра 

Имя модуля 



Соединение портов
• Позиционный принцип – сопоставление портов в объявлении модуля и 

в его экземпляре:
module ModF (A, B, C); 
ModF Umodf (a, b, cc);

• Ключевой принцип - явное указание, какой сигнал подключить к какому 
порту модуля  

module ModF (A, B, C); 
 ModF Umodf (.A(a), .B(b), .C(CC));   // в любом порядке
 
 
 
 
 

Порт  Сигнал 

ModG

g
AA

BB
CC

f

a

b

ModF

f
A

B
C



Типы данных

• Типы данных Verilog 
• Net  -  соединение (связь, цепь)

• wire – простой провод
• wand, wor – монтажное И/ИЛИ
• tri, tri0, tri1, triand, trior, trireg  -  соединения с третьим состоянием
• supply0 – постоянный 0 (GND)
• supply1 – постоянная 1 (VCC/VDD)

• Variable  - переменная
• Reg  -  регистр
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Nets (2/2)

A
B

Y
wire Y;  // declaration
assign Y = A & B; 

B

A

Y

wand Y;  // declaration
assign Y = A; 
assign Y = B;

wor Y;  // declaration
assign Y = A; 
assign Y = B;

A Y

dr
tri Y;  // declaration
assign Y = (dr) ? A : z; ‘z’ or ‘Z’ means 

high-impedance.



Verilog значения
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Integer constants
Decimal (123, 4’d15)
Hexadecimal (‘h12F, 4’haBcD)
Octal (‘o763, 3’o7)
Binary (‘b1010, 4’b1100)

// Unsized constant numbers
 659            // is a decimal number
 ‘d659 
 'h837FF    // is a hexadecimal number 
 'o7460       // is an octal number 
 4af            // is illegal (hexadecimal format requires 'h) – 'h4af

// Sized constant numbers
 4'b1001    // is a 4-bit binary number 
 5'D3       // is a 5-bit decimal number 
 3'b01x      // is a 3-bit number with the least significant bit unknown 
 12'hx        // is a 12-bit unknown number 
 16'hz        // is a 16-bit high-impedance number 

reg [7:0] my_vector_reg;

 reg [3:0] a, b, c, d;
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Правила соединения портов
• Входной порт модуля должен иметь тип 

соединение (связь)
• Выходной порт модуля может иметь тип 

или соединение или регистр 
(переменная) 

• Двунаправленные порты должны иметь 
только тип соединения

input

output

inout

reg or net

net

net

net

net

reg or net



Четырехзначный алфавит Verylog

Значение

0 Низкий логический уровень или ложно

1 Высокий логический уровень или истинно

X, x Неопределенный логический уровень

Z, z Высокоимпедансный логический уровень, 
третье состояние

Символ «?» так же используется для альтернативного представления «Z» состояния  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Test-bench файлы 
• «Тest-bench» это специальный 

уровень кода, который создает 
пользовательские входные параметры 
(stimulus) для тестируемого проекта 
(DUT, design under test)  и определяет, 
производит ли DUT ожидаемые 
(golden) выходные сигналы

• «Тest-vector» установка значений для 
всех входных портов DUT(stimuli) и 
ожидаемых значений (образцов) 
выходных портов тестируемого модуля  

• «Тest-bench», который создает 
пользовательские входные сигналы, 
образцы выходных сигналов DUT и 
сравнивает выходные сигналы с 
ожидаемыми (golden) результатами 
называется однородно-проверяющим. 

 
 

Golden model – идеальная модель, 
на выходе выдает идеальные 
ожидаемые результаты
Reference model – базовая модель, 
взятая за основу, работает 
идентично, но может быть создана с 
помощью других функций, например 
математических или аппаратная 
реализация, созданная сторонними 
разработчиками.
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Разработка структурной схемы сумматора
• Сумматор цифровая схема которая 

выполняет сложение чисел
• Одноразрядный полусумматор складывает два 

однобитных двоичных числа (А и В). На выходе 
формируется значение суммы (S) и переноса (C). 

• Полный одноразрядный сумматор складывает три 
однобитный значения (C, A and B). На выходе 
формируется значение суммы (S) и переноса (C). 

• Многоразрядный сумматор
• Суммирование с распространением переносов
• Перенос из младшего полусумматора учитывается 

старшим полусумматором

Picture has been adopted from Wikipedia 
(http://en.wikipedia.org/wiki/Half_adder).



Структура директории 

adder design

sim

syn

sim.gate

Папка с исходными кодами проекта 

Папка с результатами симуляции 

Папка с результатами синтеза 

Папка с результатами Gate-level 
симуляции 



Проект “adder” - сумматор
• Содержимое папки ‘design’

• top.v
• full_adder.v
• half_adder_gate.v
• half_adder_rtl.v
• stimulus.v
• full_adder_ref.v
• checker.v



full_adder

clk

reset
Начальные установки

Запись входных значений во входные регистры, 
формирование результата

reset
clk

cin

in1
in2 sum

cout

A
B

S

C

half_adder
module half_adder (S, C, A, B);
            output S, C;
            input    A, B;
            // описание модуля
endmodule

Модуль full_adder
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Модуль full_adder (1/3)module full_adder(sum,cout,in1,in2,cin,clk,resetb);
    output sum, cout; /выходные сигналы
    input  in1, in2, cin; /входные сигналы
    input  clk, resetb; /входные сигналы
/ объявление типов связей, сигналов и соединений
    wire   sum, cout; /соединение (проводник)
    reg    rin1, rin2, rcin; /переменная (регистр)
    wire   s1, c1, s2, c2; /соединение (проводник)
/процедурный блок - процесс
    always @ (posedge clk or negedge resetb) begin
         if (resetb==1'b0) begin
            rin1 <= 1'b0;  rin2 <= 1'b0;   rcin <= 1'b0; end 
         else begin
            rin1 <= in1;    rin2 <= in2;     rcin <= cin;
         end
    end
/создание экземпляров модулей
    half_adder_gate ha1 (.S(s1), .C(c1), .A(rin1), .B(rin2));
    half_adder_rtl     ha2 (.S(s2), .C(c2), .A(s1),   .B(rcin));
/ процедурные присваивания
    assign sum = s2;
    assign cout = c1|c2;
endmodule
always [@(список чувствительности)]
begin           многократное  повторение
...                 операторов в блоке
end

assign  / непрерывное
           / присваивание

Параллельные операторы (процессы)

Оператор ожидания
@ (A or D)  / события в А или В
@ posedge clk /фронта clk
@ negedge clk /среза clk

Оператор неблокирующего 
присваивания
X1<=1’b1;  / X1 присваивается 1
X2<=X1;    / Х2 присваивается 
                 / старое значение Х1
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Full adder (2/3)

module full_adder(sum,cout,in1,in2,cin,clk,resetb);
    output sum, cout;
    input   in1, in2, cin;
    input   clk, resetb;
 
    wire   sum, cout;
    reg    rin1, rin2, rcin;
    wire   s1, c1; wire   s2, c2;
 
    always @ (posedge clk or negedge resetb) begin
         if (resetb==1'b0) begin
            rin1 <= 1'b0;  rin2 <= 1'b0;  rcin <= 1'b0;
         end else begin
            rin1 <= in1;  rin2 <= in2; rcin <= cin;
         end
    end
 
    half_adder_gate ha1 (.S(s1), .C(c1), .A(rin1), .B(rin2));
    half_adder_rtl     ha2 (.S(s2), .C(c2), .A(s1),   .B(rcin));
 
    assign sum = s2;
    assign cout = c1|c2;
endmodule 

Имя модуля 

Объявление портов 

Описание портов 

Описание сигналов и 
соединений 

Создание экземпляров 
модулей 

internal design description

internal design description
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Full adder (3/3)
module full_adder(sum,cout,in1,in2,cin,clk,resetb);
    output sum, cout;
    input  in1, in2, cin;
    input  clk, resetb;
 
    wire   sum, cout;
    reg    rin1, rin2, rcin;
    wire   s1, c1; wire   s2, c2;
 
    always @ (posedge clk or negedge resetb) begin
         if (resetb==1'b0) begin
            rin1 <= 1'b0;  rin2 <= 1'b0;  rcin <= 1'b0;
         end else begin
            rin1 <= in1;  rin2 <= in2; rcin <= cin;
         end
    end
 
    half_adder_gate ha1 (.S(s1), .C(c1), .A(rin1), .B(rin2));
    half_adder_rtl     ha2 (.S(s2), .C(c2), .A(s1),   .B(rcin));
 
    assign sum = s2;
    assign cout = c1|c2;
endmodule
 

Verilog типы данных: связь and 
переменная 
�net : wire
�variable: reg, integer, real ... 

Экземпляры моделей, которые 
описывают соединение портов в виде 
позиционного списка 
Блоки непрерывного присваивания 
значений сигналам, которые 
срабатывают, если изменяется хотя 
бы один сигнал в правой части 
выражения. 

Этот процесс запускается, когда 
наступает событие размещенное в 
списке чувствительности.
фронт ‘clk’
срез ‘resetb’ 
Блок процедурного присваивания, 
переменные внутри блока 
инициализируются и присваиваются 
многократно, если случается событие 
==: оператор блокирующего 
присваивания 
<=: неблокирующее присваивание 

|: оператор побитового ИЛИ (OR) 



Структурная модель полусумматора (gate level)

module half_adder_gate (S, C, A, B);
            output S, C;
            input    A, B;
            and UAND (C, A, B);
            xor UXOR (S, A, B);
endmodule

A

B

S

C

Структурное описание – структура объекта, как 
композиция компонентов, соединенных между собой и 
обменивающихся сигналами. 
Структурная модель - создание экземпляров 
примитивов и модулей (использование библиотечных 
модулей, или создание собственных) 

использование
библиотечных

модулей and и  xor



Поведенческое описание объектов 
Полусумматор. Процессная форма описания поведения 

(Behavior model) 

module half_adder_beh1 (S, C, A, B);
      output S, C;
      input    A, B;
      wire     S, C;
always @ (A or B)
      begin 
      if ((A==0) or (B==1)) and ((A==0) or (B==1))
                     begin S<=1’b1; C<=1’b0; end
      else
                     begin
                     S<=1’b0;
                     if (A==0) and (B==0)
                     C<=1’b0; else C<=1’b1;
                     end
       end
endmodule

Half_add
erA

B

S

C
A B S C
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1

Объект представлен в виде “черного 
ящика”, описывают зависимость выходных 
сигналов от входных на уровне одного 
процесса. 

module half_adder_beh2 (S, C, A, B);
            output S, C;
            input    A, B;
            wire     S, C;
always
            begin 
            S<=A^B;
            C<=A&B;
            @ (A or B);
            end
endmodule



 Поведенческое описание объектов  
Полусумматор. Потоковое описание архитектуры  

(Data-flow model (RTL-модель)) 
(RTL, Register Transfer Level, Уровень регистровых передач) 

module half_adder_rtl (S, C, A, B);
            output S, C;
            input    A, B;
            wire     S, C;
            assign C = A & B;
            assign S = A ^ B;
endmodule

A

B

S

C

❖ Data-flow модель – модель потоков данных
❖ Описывает поведение архитектуры объекта, потоки данных 

функционирующие на уровне архитектуры объекта и их преобразование. 
❖ Поведение архитектуры описывается с помощью операторов непрерывных 

назначений (присваиваний), которые представляют собой параллельные 
процессы.

❖ Объект представлен архитектурным описанием, где минимальная видимая 
единица примитив RTL уровня - RTL модель 



Модели мультиплексора (Behavior model) 

 always @ (sel or a or b or c or d)
    if (sel == 2’b00) out = a;
    else if (sel == 2’b01) out = b;
    else if (sel == 2’b10) out = d;
    else out = d;

 always @ (sel or a or b or c or d)
    case (sel)
     2’b00:    out = a;
     2’b01:    out = b;
     2’b10:    out = c;
     default: out = d;
    endcase

 assign c = (s) ? b : a;

sel[1] sel[0] out
0 0 a
0 1 b
1 0 c
1 1 d

MX
a
b

outd
c

sel[0]
sel[1]

module mx_beh (sel, a, b, c, d, out);
            output out;
            input    sel, a, b, c, d;
            wire     a, b, c, d;
            wire       [1:0]sel;
            / description
endmodule



Test-bench: stimulus

module stimulus(out1,out2,out3,clk,resetb);
    output out1,out2,out3;
    input clk,resetb;
 

    reg out1,out2,out3;
 

    initial begin
        out1 <=0; out2 <=0; out3 <=0;
/ ожидание сброса тригеров в 0
        wait (resetb==1'b0);
        wait (resetb==1'b1);
/ по фронту clk генерация на выходе трех битов        
@ (posedge clk); out1=1; out2=0; out3=0;  
@ (posedge clk); out1=0; out2=1; out3=0;  
@ (posedge clk); out1=1; out2=1; out3=0;  
@ (posedge clk); out1=0; out2=0; out3=1;  
@ (posedge clk); out1=1; out2=0; out3=1;  
@ (posedge clk); out1=0; out2=1; out3=1;  
@ (posedge clk); out1=1; out2=1; out3=1;  
@ (posedge clk);
/ повторить 3 раза  
        repeat (3) @ (posedge clk);
 
        $finish;  /  
    end
endmodule

<=: неблокируемый оператор присваивания 

Initial однократно выполняемая 
конструкция, выполняется во время 
старта симуляции. 

=: оператор блокирующего присваивания, 
присваивания выполняются 
последовательно 

‘repeat’: Выполняет установку 
фиксированного количества тактов 

‘wait’ – оператор 
ожидания условия 
(выполняется, когда 
условие станет true) 

‘@’ оператор ожидания события 

$finish - Системная задача, конец 
моделирования, выполняет остановку 
симулятора и передает управление назад 
операционной системе компьютера

reset 

stimulus res
et clk 

out
1 out
2 

Full_adder 
su
m cou
t 

out
3 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Test-bench: full_adder_ref

module full_adder_ref(sum,cout,in1,in2,cin,clk,resetb);
    output sum, cout;
    input  in1, in2, cin;
    input  clk, resetb;

    wire   sum, cout;
    reg    rin1, rin2, rcin;
    

    always @ (posedge clk or negedge resetb) begin
         if (resetb==1'b0) begin
            rin1 <= 1'b0;
            rin2 <= 1'b0;
            rcin <= 1'b0;
         end else begin
            rin1 <= in1;
            rin2 <= in2;
            rcin <= cin;
         end
    end

    assign {cout, sum} = rin1+rin2+rcin;

endmodule

Оператор конкатенации ({, }) объединение 
двух или более значений в 
последовательность.
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Test-bench: checker

module checker(in1,in2,cin,sum,cout,sumr,coutr,clk,resetb);
    input in1,in2,cin,sum,cout,sumr,coutr,clk,resetb;
    always @ (clk) begin
        if ({cout,sum}=={coutr,sumr})
                 $display($time,,"correct");
        else $display($time,,"error result=%b expect=%b",  {cout, sum}, {coutr,sumr});
    end
endmodule

Time – системная функция возвращает текущее модельное время, целое 
64-битное значение времени, масштабируемое соответственно единице 
временного масштаба модуля (timescale), установленной в нем 

$time ;

Display – системная задача, вывод информации с новой строки на экран.

 $display ( «текст с символами форматирования», list_of_arguments );
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Test-bench: 
top

module top;
   wire in1, in2, cin; 
   wire sum, cout, sumr, coutr;
   reg  clk, resetb;
   full_adder Ufa (.sum(sum), .cout(cout), .in1(in1), .in2(in2), .cin(cin), .clk(clk), .resetb(resetb));
   full_addr_ref Urf (.sum(sumr), .cout(coutr), .in1(in1), .in2(in2), .cin(cin), .clk(clk), .resetb(resetb));
   stimulus    Ust (.out1(in1), .out2(in2), .out3(cin), .clk(clk), .resetb(resetb));
   checker    Uck (.in1(in1), .in2(in2), .cin(cin), .sum(sum), .cout(cout), .clk(clk) , .resetb(resetb));
/ генератор синхроимпульсов с периодом 5ns 
initial begin
          clk <= 0;
          forever #5 clk = ~clk;
  end
initial begin
          resetb <= 1’b0;
          #200 resetb <= 1’b1;
  end
  initial begin
          $dumpfile("wave.vcd");
          $dumpvars(1);
          $dumpvars(1, Ufa);
end
endmodule

Dumpfile задача для установки имени VCD file.

$dumpfile( filename ) ;

Dumpvars задача для установки переменных для записи в VCD file

$dumpvars ( level, [ list_of_mod_or_var );

Initial конструкция выполняется один раз во время 
инициализации

Forever – непрерывное назначение

Top-level модуль содержит весь 
проект, и не имеет входных 
портов.
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Contents
• Design flow overview
• Hello world

• GUI based
• Command based

• Module
• Declaration
• Instantiation
• Port
• Test-bench

• Adder example
• What is adder
• Directory structure
• Example design
• Simulation
• Synthesis
• Gate-level simulation
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Contents
• Adder example

• What is adder
• Directory structure
• Example design
• Simulation
• Synthesis
• Gate-level simulation
• Map & PnR
• Static timing analysis
• FPGA-based co-simulation

Использование 
САПР



Результаты моделирования
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Моделирование с использованием ModelSim GUI
• Invoking ModelSim form start menu
• Create new project
• Add design files
• Compile
• Wave setting
• Simulation
• Invoking ModeSim project
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Invoking ModelSim from start menu
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File->New->Project
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Specify project name and location
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File->Add to Project->Existing File
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Add files
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After adding files
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Compile->Compile All
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After compilation
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View->Debug Windows->Wave
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After adding wave window
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Select Library tab
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Run simulation with top-level
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After simulation



Verilog tutorial  ( 46 )

Selecting signals to be view
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After selection
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Run-All
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Create a new project
• Invoke ModelSim
• File 🡪 New 🡪 Project
• Specify ‘Project Name’ and ‘Project 

Location’

DIY
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Add existing file
• Add the Verilog design file

DIY
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Compile

DIY
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Compile

DIY
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Compile

DIY
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Simulation

DIY
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Quit

• There should be ‘hello.mpf’, which is 
ModelSim project file.

DIY



Схема до лабораторної роботи №4
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